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Chapter 1 

What is the Home Control Assistant? 

In today’s complex world, busy people can benefit from a home environment that anticipates their 

needs and helps take care of itself.  For instance, suppose your house could: 

• Turn on outside and entryway lights at dusk every day, or before you get home from work on 

weekdays? 

• Automatically run the hot tub filter during the day, or start the heater, filter, and turn on the 

lights all at the flick of one switch? 

• Dim hall lights, turn off a ceiling light, and turn on the children’s night light at a preset time 

every evening? 

• Turn on kitchen lights, and start the coffee pot at the same time every weekday morning? 

• Turn all the lights in the house on or off when you press one switch at your bedside? 

The Home Control Assistant can help you program your house to automatically respond to your 

typical schedule on weekdays, or a weekend or vacation schedule.  You can set up schedules to 

make your home looked lived in when you are away, and save energy by automatically turning 

lights off after you’re in bed. 

This chapter introduces the Home Control Assistant, and discusses the conventions of the guide 

and common procedures of HCA.  This chapter includes sections on: 

• About this guide 

• Quick tour of HCA  

• Using the menus 

• Using the status bar 

• Using the properties dialog boxes 

- Home Properties dialog box 

- HCA Options dialog box 

• The conventions used in this guide 

- Procedures and operations common to HCA 

- Common Windows procedures used in HCA 

About this guide 

This user guide walks you through the process for setting up a typical device and shows you how 

to set up more complex schedules and programs to help automate your home.  This first chapter 

includes an introduction to and quick tour of the Home Control Assistant (HCA), showing what 

HCA looks like and discussing the use of ribbon, status bar, and the Properties dialog boxes.  This 

is followed by a section on the conventions and typical Windows procedures used in this guide.   

This guide is set up in chapters that discuss the major procedures that you can use in working with 

HCA. In addition to the main chapters, there are appendixes that describe specific features of HCA 

or the automation hardware supported. 
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Quick tour of HCA 

To start the Home Control Assistant once you have installed it: 

1. From the Windows task bar, click the Start button. 

2. Choose Programs. 

3. Then click Home Control Assistant.  

 

The Home Control Assistant window is split into two panes.   

• The left pane, the design pane, shows the HCA design outline with items in the design 

organized into folders.  Everything in the left pane has properties:  simply right-click the 

element you want to access and choose Properties from the popup menu.   

• The right pane, the display pane, is reserved for the displays in your design, and at different 

times also shows the Visual Scheduler, Visual Link Editor, and messages.  

As with a typical Windows environment, you can re-size the panes by clicking the divider between 

the two panes, and moving it either left or right to achieve the relative sizes that you want.  You 

can even close one side entirely to show just the other side. 

Across the top of the Home Control Assistant you see the Ribbon which contains a number of 

categories – tabs – that control buttons to activate various features of HCA.  Across the bottom of 

the display pane is a tab bar that shows a tab for displays in your design. Across the bottom of the 

whole window is a status bar. 

Opening and Closing HCA 

When you first start HCA, its main window appears on the screen.  Also 

in the notification area on the taskbar, a small HCA icon appears as 

shown to the left. 
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Unlike other Windows programs you may be familiar with (word processors, spreadsheets, email 

programs), HCA must be running 24/7 on your computer in order to control your home. To make it 

easier to keep HCA running all the time, and to help prevent you from inadvertently terminating 

HCA, HCA works a bit differently than these other programs. 

There are five operations that are important to understand: 

Maximize the HCA Window 

The HCA Window is maximized in the same manner as most Windows programs.  Using the left 

mouse button, click on the maximize button on the upper right-hand corner of the HCA window.  

The HCA window expands to fill the whole display. 

Minimize the HCA Window 

The HCA Window is minimized in the same manner as most Windows programs.  Using the left 

mouse button, click on the minimize button on the upper right-hand corner of the HCA window.  

HCA is removed from the display and appears in the Windows Task Bar as a button labeled with 

your home design name. 

Hide the HCA Window 

To hide HCA and have only the small icon in the system notification area, select Exit from the File 

menu.  Unlike other programs this does not terminate HCA.  This operation can also be done by 

clicking with the left mouse button on the close icon on the upper right-hand corner of the HCA 

window. 

Open the HCA Window 

To open the HCA window when HCA only appears as an icon in the system notification area, 

move the mouse over the icon and click the right mouse button.  Select Open from the popup 

menu. 

Terminate HCA 

Open the application menu by clicking on the application “Bubble” and then select Shutdown from 

menu 

Using the ribbon 

Across the top of the Home Control Assistant window is a ribbon menu   There are eight categories 

– tabs - with various controls in each.   

 

The Control category contains controls that show the current state of your design.  For example, 

the current schedule and home mode and shown in dropdown controls.  To change the mode of 

schedule all you need do is to change the selection in those dropdowns. 

Also shown is the current inspector and alert report given in shorthand. The number of red and 

yellow problems identified, and the count of alerts reported by the alert manager. 

The buttons in the Tools panel open viewers for the Logs, Variable inventory, and the 

communications monitor. 

• HCA Status.  Opens a dialog box that gives the current design path and name, current 

schedule, next scheduled event; a list of the programs running, and sunrise and sunset times. 

• Variables.  The Variable Inventory dialog box shows all the variables and their current values 

in your design.  A Variable is used to represent various types of information including status, 

values, times, etc. which are used in HCA programs 
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• Log1m, Log2, Log3.  Show a viewer for each log.  

• Comm Monitor.  A window that shows the lowest level communication between HCA and the 

attached automation interfaces 

The Design category contains controls for modifying your design.  For example, adding new 

programs, devices, groups, and schedules.  Also, tools for accessing the properties of your design. 

The Tools category contains tools for configuring the Control UI, Status export, etc. Also in this 

category are the tools for configuring various aspects of HCA like the Visual Programmer and 

debugger. 

The Schedule category contains the controls necessary to work with the Visual Scheduler.  This is 

described in the Visual Schedule chapter. 

The Power Track category is to view both current power uses and to view historical power graphs 

that show power usage in your home over time. 

The Protocols category contains tools customized for specific attributes of the various automation 

protocols supported by HCA.  For example, special facilities for working with Insteon and UPB. 

The Interfaces category contains tools for working with all supported automation interfaces and 

for weather data. 

 

One nice feature of the Interfaces category is that the icons show you which interfaces have been 

configured, which are connected and working, and which are not. 

In the above picture the Insteon PowerLinc and the UPB interface has been configured and are 

working – green check. If they were not working the green check would have been replaced by a 

exclamation point. The IR interfaces have not been configured - red bars. 

The HINT System 

HCA contains a system that may make learning all the features of HCA a bit simpler.  When you 

are working with the HCA User Interface if your actions could be done in a better way, or there is 

a feature you may not be aware of, HCA displays a hint.  This can be done in one of two ways. 

First, the hint can just appear on the screen in a popup window.  Or, the Hint Indicator in the status 

bar can change to show that HCA has a hint.  In this case you must wither click on it or press the 

F1 key to show the hint. 

You can resize and move the hint window out of the way and leave it on the screen as you work.  

HCA updates it with whatever hint it has about what you are doing.  

In the Help menu is an option to select your preference.  If Auto Hint Display has a checkmark 

next to it, hints automatically appear.  Without the checkbox the start bar method is used. 

On each hint popup dialog is a checkbox that you can use to have HCA no longer show that hint.  

As you get more sophisticated you will have no need of some of the hints. 

If you find yourself wanting to get the hints back that you turned off, select Enable All Hints from 

the Help menu. 
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Using the properties dialog boxes 

In HCA, nearly everything has properties.  Most properties dialog boxes are available from a 

popup menu that you see when you right click an item in either pane of HCA.   

• In the design pane of the HCA, right click an element word, and choose Properties from the 

popup menu.  The properties dialog box for the item appears. 

• In the display pane, right-click on the display background, or on an icon, or the visual 

scheduler background to display the popup menu with a properties dialog box for that item. 

These properties dialog boxes generally have multiple tabs, and include items like the name, icon, 

restart choices, green settings, etc.  There are usually other tabs with options specific to the object 

or the type of object. 

 

Home Properties dialog box 

You can access your Home Properties dialog box by either right clicking Home Contents in the 

design pane, or by clicking the Properties button in the Design category. 

 

The home Properties dialog box shows the information specific to your home design that you 

entered when you first set up your HCA design.  It provides tabs where you can modify or add 

settings later for these properties, including: 

• Name of the design 

• Location—city, state, longitude and latitude 

• Light and Dark settings.  How HCA determines if it is light or dark. There are many ways to 

do this. 
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• Security settings—passwords to modify the design, control programs and devices, and activate 

or deactivate HCA  

• Identification info – name, address, email, etc – for both the home owner and installer 

• Any notes about the design. 

See the chapter on Home Properties for more information. 

HCA Options dialog box 

You can access the Home Control Assistant Options dialog box by using the HCA Options button 

from the application menu. 

 

The Home Control Assistant Properties dialog box is a very powerful tool where you can modify 

or add settings for the general properties for the HCA program.  This is information about how to 

run HCA, including: 

• Startup—design, size, power failure information, and auto save options  

• Client Server – Opens for the HCA Server 

• Color and Theme—select the default color and theme used for display background in the 

development and control interface. 

• Control Interface – Options for the Control Interface 

• Design Pane – design pane and time format options. 

• Display Pane —what you’ll see in the display pane of HCA  

• Hardware—Automation interfaces and how they are attached to your computer. 

• Visual Programmer – configure Visual Programmer options 

• Advanced – other options  

• Legacy – Selection for older legacy hardware and features. 
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• Extra – Extra feature codes that enable/ disable some special HCA features 

Refer to the HCA Options chapter for more detailed information. 

 

The Design Pane and the Display Pane 

As described above, the HCA main window is split into two parts.  The display pane is described 

in the chapter on displays.  The display pane is described here in the next section.  

 

The Design Pane 

The left pane of the HCA Window, called the Design Pane contains a list of the elements of your 

design.  There are a few items not shown and these will be described later. 

Every object in your design can have a name and most objects require a name.  These names 

appear in the design pane.  Each object is also contained within a room or folder.  You can have as 

many objects as you need and place them in as many rooms or folders as you need.  The only 

limitation is that each item within the room or folder must have a unique name, and no room or 

folder can contain another room or folder. 

What’s the difference between a room and a folder?  

While rooms are a good way to organize your 

device, programs, and groups, there are special 

operations that allow you to treat all the devices in a 

“room” as a single set of devices. This is all 

explained in the chapter on rooms. Folders are 

much simpler and are just an organizational method. 

Hint: Rather than say “folder or room” everywhere, 

the term folder is used and means either folder or 

room unless otherwise stated. 

Why would you want to organize your design info 

folders?  One reason may be to help group those 

things together that work in unison.  For example, 

one room may have three devices, a group, and 6 

programs.  All of these work together as part of 

your automation solution so it makes sense to have 

them in one folder.  And perhaps the folder name is 

the name of the room. 

How do you organize things that don’t fit into a 

simple room-by-room organization?  That’s up to 

you!  One way would be to have a folder called 

Home that contains all those items that work with 

the house as a whole.  Or have a folder for each 

floor that, in a similar way, contains things that 

handle that floor.   

 

In this example, the design contains a number of Rooms.  One room is for the Back Entry, another 

for the Bath, and so on. 



Chapter 1—What is the Home Control Assistant? 

8 The Home Control Assistant 

When you open the properties for each object type, on the first tab is the place where you can 

select which folder or room the object is placed in.  

Design Pane  
 

There are several options for sorting the individual folder/room contents and the sorting for the 

order of the folders displayed. 

Right click on the folder/room name and the sort options are n the popup menu. 

 

Two-part names 

In HCA everything has a name.  It’s always hard to come up with names for things in your design.  

It may seem that each room of your home has computer controllable lamps and ceiling lights.  You 

could call them “Den Lamp” “Den Ceiling Lights”, “Bedroom lamp”, or come up with some other 

naming convention.  But with the ability to assign objects to folders, HCA lets you call them the 

same name, as long as they are in different folders. 

For example, assume you have two lamps.  If you create two folders: one called Den and the other 

Bedroom, then you can create two devices and call each Lamp. 

This can get confusing: which “lamp” is which?  HCA always shows them as “Den – Lamp” and 

“Bedroom – lamp” whenever you must choose a device. 

When names are managed in this way, HCA calls them Two Part Names.   

With two-part names, where does the first part of the name come from?  It comes from the name of 

the folder the object is stored in.  Where does the second part of the name come from? It is the 

name you entered when you created the object.  For example, when you used the “new device” 

wizard to add the device to your design you gave the new device a name. 

Two parts names are enabled or disabled by selecting HCA – Properties from the menu and 

choosing the Design tab: 

Keep these points in mind as you work with the design pane: 

• Each object always is stored in a folder. 

• The design pane can be organized to show objects within their folders or within their 

type. 
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• Names in HCA are two part where the name is the folder name and the object name taken 

together. 

Working within the design pane 

There are several things you can do in the design pane to help create an organization that is best 

for your use. 

1. You can rename a device, program, group, or schedule.  Right click on the name and 

select Rename from the popup menu.   You can then enter the new name. 

2. You can rename a folder.  This is done in the same way as described above. 

3. You can reorder the folders, by grabbing the folder, dragging it and dropping it on the 

folder you want it to appear after. 

4. You can drag an object from one folder to another.  This changes which folder it is stored 

in.  Each object must be stored in some folder and can only be stored in a single folder.  

That is, one object can’t appear in two different folders. 

5. You can close or open a folder.  To close the folder, click on the small icon next to it.  All 

the objects in the folder disappear.  To have them reappear just click on the small icon 

next to it.  HCA will remember which folders are open and closed when you close and 

reopen your file. 

6. You can select more than one device, program, or group and operate upon them all at 

once.  Not all operations are possible if you have more than one item selected.  In general, 

you can control them all on, all off, suspend, resume, delete or open their properties.  You 

can also drag more than one object from one folder to another to change their location. 

You can also control the order of the objects within a folder.  To do this, right click on the 

folder name in the design pane and select one of the ordering options. 

The small icon next to the name in the design pane can be changed in only one way.  You 

must open the properties for the object and if there are any choices, select an icon from the 

choices displayed.  There are a limited set of choices, if any, and you can’t add you own icons 

to the design pane like you can for the display pane. 

Design pane information 

In addition to a simple listing of your design elements by name and in folders, the design pane also 

shows the state of the object in two ways. 

1. If the device, group, or controller is ON or if a program is running, the background of the 

icon in the design pane is colored yellow. 

2. If the device, program, or group is suspended a red slash is drawn across it. 

3. If the device, program, or group ism disabled a black slash is drawn across it. 

 

Working with the design and display panes together 

HCA supports drag and drop between the design pane and the display pane.  To add an icon to a 

display (one that supports icons – see the Displays chapter for more information), just grab the 

device, program, or group name and drag it onto the display pane and drop it.  You can select more 

than one object and drag them as a group onto a display. 

In addition to this drag and drop method, you can also choose which displays an icon for an object 

appears by opening its properties dialog and making changes on the Display tab. 
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What doesn’t appear in design pane 

The main elements of your design - devices, programs, groups, schedules, and schedule entries - 

are listed in the design pane.   

Other elements of your design like the calendar, keypads, log filters to name just some are not 

listed in the design pane. 

 

The conventions used in this guide 

The following are the common protocols used in this Guide. 
 

Convention Definition 

Arial font Text in this font indicates either entries that you type 
into HCA, or responses or messages from the HCA 
system for you to read.  

HCA An abbreviation for the Home Control Assistant. 

Hint A hint is a special trick, a neat way of doing 

something, or a reminder of other HCA operations. 

web tip A web tip points you to the Home Control Assistant 

web location for more information on a particular 

subject. 

 

In this guide, we assume that you are familiar with the use of Windows, and the most common 

Windows conventions, such as click, drag and drop, double-click, right mouse click, use of the 

browse function, directories, and files.  However, some of these common Windows conventions 

most often used in HCA are documented in the section following. 

For instance, if a procedure says click, we mean to use the mouse button you most often use, 

generally the left.  If you need to right-click an item, we’ll specify that. 

Procedures and operations common to HCA  

There are several common tasks that occur in multiple places in HCA, and that you may find 

yourself completing in different wizards, or for the various properties dialog boxes.  Rather than 

repeating them or explaining them each time they are used, we have placed them here to be less 

repetitive.  

Selecting items for use in a particular area 

This may be used to place icons for a device, group, or program on a display, to place members in 

a group, and in several other wizards.  Regardless of the specific wizard or dialog box, there will 

be two boxes, separated by two arrow buttons.   

You click a listed item in the left box, and then click the right arrow  → pointing to the right box, 

and the item moves into that box.  In some cases you can move one, some, or all of the items to the 

right column.  If you find that you have mistakenly moved something to the right box, you can 

move it back. Select the item from the right box and click the left arrow    to return it to the left 

column. 
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Object names 

As described above, most HCA objects have names.  You may use as many characters as you like 

to name your objects except for dash, left square bracket or right square bracket.  There is no 

practical limit to the length of any name. 

Printing  

HCA provides printing support for details on several elements of your design, using a typical 

Windows format.  You can select any of the four print commands available from the Application 

menu: 

• Print—provides the typical Windows print dialog box, allowing you to determine your print 

range, number of copies, and so on. 

• Pint Preview—shows you a reduced, full page layout of what you are printing. 

• Page Setup—opens a dialog box where you can set the elements you want to print:  home 

information, rooms, folders, displays, schedules, device address info, Insteon network 

description, protocol bridges, flags, and references.  

• Print Setup—opens a dialog box where you can view and set the name and location of your 

printer, paper size and orientation. 

The HCA printouts contain information about the elements in your design that you have selected 

using the Page Setup command.  HCA formats and prints the information you chose in a vertical 

list, with headings for the different sections.  The path for your design is included at the top of each 

page, along with the printout page number.  Because the printouts can get long, you may want to 

specify only those elements that you are interested in seeing each time you print. 

 

Common Windows procedures used in HCA  

There are also typical Windows procedures that are frequently referenced in HCA procedures.  We 

have gathered a few of them here, for your reference in case you are not familiar with them.   

Right click for popup menu  

Most objects in HCA have properties attached to them.  You can generally get to the properties for 

the object by using the mouse, and right clicking on the object.  To do this: 

1. Move the mouse pointer to or over the object in question. 

2. Click the right mouse button.  (Unless you’re using a mouse device set up for a left-hander, in 

which case, you would click the left mouse button.)  This is the button that you don’t normally 

use. 

A popup menu appears. 

3. With the mouse, move the pointer down the popup menu until you get to the menu command 

you want, and click the left (normal) mouse button. 

 In the case of properties, the properties dialog box opens.   

Drag and place 

In HCA there are several things—icons on a display, entries on the visual scheduler—that you may 

want to move from one place to another.  This is very easy to do with the typical Windows drag 

method.   

To drag an icon to another location: 

Move the mouse pointer to or over the object in question. 
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1. Click the left mouse button.  (Unless you’re using a mouse device set up for a left-hander, in 

which case, you would click the right mouse button.)  This is the button that you use most of 

the time. 

2. While you continue to hold the mouse button down, move the mouse pointer to the new 

location for this object.  You will see the object moving with your pointer.  

3. When you reach the correct location, release the mouse button. 

 The object “drops” into its new place. 

 

Viewing the hierarchy of your design  

Several areas in HCA are organized in hierarchies like the design pane.  These hierarchies use the 

Windows convention of small icons on the left margin to indicate the status of the hierarchy. On 

icon shows that the contents of the folder is hidden and another when it is seen.  

This system is the same as used by the Windows File Explorer, so you probably already know how 

to work it. 
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